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SAS-4 Compliance Test Application — At A Glance
The Keysight D9040SASC SAS-4 Compliance Test Application enables the testing of SAS-4 devices 
with the Keysight Infiniium oscilloscope, based on the SAS-4 Standard that defines the physical layer 
of the SAS interconnect. SAS-4 operates at 22.5 Gb/s.

The SAS-4 Compliance Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Provides detailed information for each test that has been run, and lets you specify the thresholds 
at which marginal or critical warnings appear.

• Creates a printable HTML report of the tests that have been run.

Required Equipment and Software

In order to run the SAS-4 Compliance Test Application, you need the following equipment and 
software:

• Infiniium Z-Series, V-Series, Q-Series, or UXR-Series (UXR0334A) oscilloscope. Keysight 
recommends using 33 GHz and higher bandwidth oscilloscope.

• The minimum version of Infiniium oscilloscope software (see the D9040SASC SAS-4 Compliance 
Test Application release notes).

• D9040SASC SAS-4 Compliance Test Application software.

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Keysight also recommends using a second monitor to view the automated test application.

For the list of required licenses to run this application, refer to the Data Sheet.

NOTE The current SAS-4 compliance test application is based on the Serial Attached SCSI-4 (SAS-4) 
Specification Revision 09.

NOTE  The group of tests specified in this Methods of Implementation document pertains to the SAS-4 
specifications. The specification defines the electrical requirements of the signals for 1.5, 3.0, 6.0, 
12.0, and 22.5 Gbps bit rates at IT and CT test points. This Method of Implementation document, 
however, describes the tests for the 22.5 Gbps bit rate only.

NOTE The tests performed by the SAS-4 Compliance Test Application are intended to provide a quick 
check of the electrical health of the DUT. This testing is not a replacement for an exhaustive test 
validation plan.
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In This Book
This manual describes the tests that are performed by the SAS-4 Compliance Test Application in 
more detail.

• Chapter 1, “Installing the SAS-4 Compliance Test Application” describes how to install and license 
the automated test application software (if it was purchased separately).

• Chapter 2, “Preparing to Take Measurements” describes how to start the SAS-4 Compliance Test 
Application and gives a brief overview of how it is used.

• Chapter 3, “SAS Test Application Overview” provides an overview of the SAS-4 Compliance Test 
Application.

• Chapter 4, “TX SAS-SAS Down Spreading Spread Spectrum Clocking Requirements Tests” 
describes the SAS Down Spreading Spread Spectrum Clocking Requirements tests.

• Chapter 5, “TX SAS-SAS Center Spreading Spread Spectrum Clocking Requirements Tests” 
describes the SAS Center Spreading Spread Spectrum Clocking Requirements tests.

• Chapter 6, “NRZ Data Signaling Requirements Tests” describes the NRZ Data Signaling 
Requirements tests.

• Chapter 7, “Coefficient Requests and Circuit Response Requirements Tests” describes the 
Coefficient Requests and Circuit Response Requirements tests.

• Chapter 8, “OOB Signaling Tests” describes the Out Of Band Signaling tests.

• Chapter 9, “Calibrating the Infiniium Oscilloscope” describes how to calibrate the oscilloscope in 
preparation for running the SAS-4 automated tests.

See Also

• The SAS-4 Compliance Test Application’s Online Help, which describes:

• Starting the SAS-4 Compliance Test Application.

• Creating or opening a test project.

• Acquisition Setup.

• Setting up the precision probe/cable.

• Setting up the SAS-4 test environment.

• Selecting tests.

• Configuring selected tests.

• Defining compliance limits.

• Connecting the oscilloscope to the DUT.

• Running tests.

• Automating the application.

• Viewing test results.

• Viewing/exporting/printing the HTML test report.

• Understanding the Report.

• Exporting measurement results to web repository.

• Saving test projects.

• Installing/removing add-ins.

• Controlling the application via a remote PC.

• Using a second monitor.
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1 Installing the SAS-4 
Compliance Test Application

Installing the Software  /  14
Installing the License Key  /  15

If you purchased the D9040SASC SAS-4 Compliance Test Application separately, you must install 
the software and license key.
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Installing the Software

1 Make sure you have the minimum version of Infiniium Oscilloscope software (see the D9040SASC 
test application release notes) by choosing Help>About Infiniium... from the main menu.

2 To obtain the SAS-4 Compliance Test Application, go to Keysight Web site: 
http://www.keysight.com/en/pc-1152185/oscilloscope-software.

3 Navigate to the SAS-4 Compliance Test Application software download. 

4 Follow the instructions to download and install the application software.

http://www.keysight.com/find/scope-apps-sw/
http://www.keysight.com/en/pc-1152185/oscilloscope-software
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Installing the Keysight SAS-4 Compliance Test Application 1

Installing the License Key

To procure a license, you require the Host ID information that is displayed in the Keysight License 
Manager application installed on the same machine where you wish to install the license.

Using Keysight License Manager 5

To view and copy the Host ID from Keysight License Manager 5:

1 Launch Keysight License Manager on your machine, where you wish to run the Test Application 
and its features.

2 Copy the Host ID that appears on the top pane of the application. Note that x indicates numeric 
values.

Figure 1 Viewing the Host ID information in Keysight License Manager 5

To install one of the procured licenses using Keysight License Manager 5 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager.

3 From the configuration menu, use one of the options to install each license file.

Figure 2 Configuration menu options to install licenses on Keysight License Manager 5

For more information regarding installation of procured licenses on Keysight License Manager 5, 
refer to Keysight License Manager 5 Supporting Documentation.

https://www.keysight.com/main/redirector.jspx?action=ref&nid=-33002.0.00&lc=eng&cc=IN&ckey=2953922&cname=EDITORIAL&nfr=-33002.0.02
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Using Keysight License Manager 6

To view and copy the Host ID from Keysight License Manager 6:

1 Launch Keysight License Manager 6 on your machine, where you wish to run the Test Application 
and its features.

2 Copy the Host ID, which is the first set of alphanumeric value (as highlighted in Figure 3) that 
appears in the Environment tab of the application. Note that x indicates numeric values.

Figure 3 Viewing the Host ID information in Keysight License Manager 6
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Installing the Keysight SAS-4 Compliance Test Application 1

To install one of the procured licenses using Keysight License Manager 6 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager 6.

3 From the Home tab, use one of the options to install each license file.

Figure 4 Home menu options to install licenses on Keysight License Manager 6

For more information regarding installation of procured licenses on Keysight License Manager 6, 
refer to Keysight License Manager 6 Supporting Documentation.

https://www.keysight.com/main/redirector.jspx?action=obs&nid=-33002.0.00&lc=eng&cc=IN&ckey=2994142&pubno=&ltype=LitStation&ctype=EDITORIAL&nfr=-33002.0.02
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2 Preparing to Take 
Measurements

Calibrating the Oscilloscope  /  20
Starting the SAS-4 Compliance Test Application  /  21

Before running the SAS-4 automated tests, you must calibrate the oscilloscope. After the 
oscilloscope has been calibrated, you are ready to start the SAS-4 Compliance Test Application and 
perform the measurements.
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Calibrating the Oscilloscope

• If you have not already calibrated the oscilloscope and probe, see Chapter 9, “Calibrating the 
Infiniium Oscilloscope.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the calibration temperature, 
internal calibration should be performed again. The delta between the calibration temperature and 
the present operating temperature is shown in the Utilities>Calibration menu.

NOTE If you switch cables between channels or other oscilloscopes, it is necessary to perform cable and 
probe calibration again. Keysight recommends that, once calibration is performed, you label the 
cables with the channel on which they were calibrated.
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Preparing to Take Measurements 2

Starting the SAS-4 Compliance Test Application

1 From the Infiniium Oscilloscope’s main menu, choose Analyze>Automated Test Apps>D9040SASC 
SAS-4 Test App.

Figure 5 Starting the SAS-4 Compliance Test Application

NOTE If the D9040SASC SAS-4 Test App does not appear in the Automated Test 
Apps menu, the SAS-4 Compliance Test Application has not been installed 
(see Chapter 1, “Installing the SAS-4 Compliance Test Application”).
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Figure 6 The SAS-4 Compliance Test Application’s default window

Figure 5 shows the procedure to launch the SAS-4 Compliance Test Application and Figure 6 shows 
the SAS-4 Compliance Test Application default window. The tabs in the main pane show the steps 
you take in running the automated tests:

Tab Description

Set Up Lets you identify and set up the test environment, including information about the device under 
test.

Select Tests Lets you select the tests you want to run. The tests are organized hierarchically so you can select 
all tests in a group. After tests are run, status indicators show which tests have passed, failed, or 
not been run, and there are indicators for the test groups.

Configure Lets you configure test parameters. This information appears in the HTML report.

Connect Shows you how to connect the oscilloscope to the device under test for the tests to be run.
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Preparing to Take Measurements 2

Run Tests Starts the automated tests. If the connections to the device under test need to be changed while 
multiple tests are running, the tests pause, show you how to change the connection, and wait for 
you to confirm that the connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the application.

Results Contains more detailed information about the tests that have been run. You can change the 
thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.

NOTE The configuration options shown under the Set Up tab of the SAS-4 
Compliance Test Application main window dictate the availability of various 
tests. You may have to select more than one configuration option to make 
some tests available, else they appear unavailable/disabled. To know more 
about the configurable options under the Set Up tab that must be selected 
for each test, refer to the section, “Test Availability” under the method of 
implementation for each test in this document.

Tab Description
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Online Help Topics

For information on using the SAS-4 Compliance Test Application, see its Online Help (which you can 
access by choosing Help>Contents... from the application’s main menu).

The SAS-4 Compliance Test Application’s Online Help describes:

• Starting the SAS-4 Compliance Test Application.

• Creating or opening a test project.

• Acquisition Setup.

• Setting up the precision probe/cable.

• Setting up the SAS-4 test environment.

• Selecting tests.

• Configuring selected tests.

• Defining compliance limits.

• Connecting the oscilloscope to the DUT.

• Running tests.

• Automating the application.

• Viewing test results.

• Viewing/exporting/printing the HTML test report.

• Understanding the Report.

• Exporting measurement results to web repository.

• Saving test projects.

• Installing/removing add-ins.

• Controlling the application via a remote PC.

• Using a second monitor.
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3 SAS Test Application 
Overview

Overview  /  26
Making Hardware Connections for SAS-4 Compliance Testing  /  27
SAS Test Application Test Groups  /  40
Test Availability in the SAS-4 Compliance Test Application  /  41

The Keysight D9040SASC SAS-4 Compliance Test Application enables compliance testing of the 
SAS devices, in adherence to the SAS-4 specifications. This chapter describes the required hardware 
connections for SAS-4 compliance testing, the test groups in the SAS-4 compliance test application, 
and the test availability criteria.
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Overview

The group of tests specified in this Methods of Implementation document pertains to the SAS-4 
specifications. The specification defines the electrical requirements of the signals for 1.5, 3.0, 6.0, 
12.0, and 22.5 Gbps bit rates at IT and CT test points. This Method of Implementation document, 
however, describes the tests for the 22.5 Gbps bit rate only.
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SAS Test Application Overview 3

Making Hardware Connections for SAS-4 Compliance Testing

The required hardware and interconnections vary, depending on the configured test pattern source 
and use of RealEdge feature in Infiniium Q-Series and Z-series oscilloscopes.

Infiniium Q-Series and Z-Series oscilloscopes support RealEdge technology that allows for 63 GHz of 
bandwidth on two channels. In these oscilloscopes, there are two additional 1.85 mm channel inputs, 
1R and 3R that enable support for RealEdge feature. Hence, if you are using RealEdge, the 
connection diagrams will vary from the setups not using RealEdge.

To select the RealEdge channels in the SAS-4 application, go to Configure tab and set the Tx 
Connection configuration variable to Single-Ended, Real Edge Channels.

The Test Pattern Source setting offers the following options:

• BIST_L

• BIST_T

• SavedWFM

BIST_T

For BIST_T as the test pattern source, there is no additional device or more specifically a pattern 
generator required. The SAS test application does not control the stimulus using a pattern generator. 
The user must manually configure the test patterns during tests. The SAS test application prompts 
the user for test patterns.

Since there is no pattern generator involved in this arrangement, the connection setup involves the 
SAS Test Fixture attached to SAS DUT and connected with Channel 1 and Channel 3, Channel 2 and 
Channel 4, or Channel 1R and 3R (for RealEdge) of the oscilloscope.

NOTE The use of RealEdge feature in Infiniium Q-Series and Z-series oscilloscopes is 
optional.

NOTE Sampling Rate is fixed at 160GSa/s when RealEdge is enabled.
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Figure 7 BIST_T Connection Diagram with Channel 1 and Channel 3

Figure 8 BIST_T Connection Diagram with Channel 2 and Channel 4
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SAS Test Application Overview 3

Figure 9 BIST_T Connection Diagram with Channel 1R and Channel 3R

BIST_L

With the BIST_L test pattern source, the SAS test application controls the stimulus using 81134A, 
N4903B, M8020A, or M8040A to generate the required test pattern and the DUT then reads/loops 
back the test pattern generated by the stimulus.

For the 22.5 Gbps bit rate, M8020A and N4903B require a multiplexer to expand the bit rate up to 
the required limit. M8020A uses M8061A or M8062A as the multiplexer while N4903B can use either 
N4876A or M8061A as the multiplexer. Refer to the following connection diagrams. 

Additionally, the connection diagrams display the required connections when using M8040A BERT 
for OOB and non-OOB tests.
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Figure 10 BIST_L Connection Diagram with 81134A with Channel 1 and Channel 3

Figure 11 BIST_L Connection Diagram with 81134A with Channel 2 and Channel 4
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SAS Test Application Overview 3

Figure 12 BIST_L Connection Diagram with 81134A with Channel 1R and Channel 3R

Figure 13 BIST_L Connection Diagram with N4903B JBERT and M8061A Multiplexer with Channel 1 and Channel 3
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Figure 14 BIST_L Connection Diagram with N4903B JBERT and M8061A Multiplexer with Channel 2 and Channel 4

Figure 15 BIST_L Connection Diagram with N4903B JBERT and M8061A Multiplexer with Channel 1R and Channel 
3R
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SAS Test Application Overview 3

Figure 16 BIST_L Connection Diagram with N4903B JBERT and N4876A Multiplexer with Channel 1 and Channel 3

Figure 17 BIST_L Connection Diagram with N4903B JBERT and N4876A Multiplexer with Channel 2 and Channel 4
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Figure 18 BIST_L Connection Diagram with N4903B JBERT and N4876A Multiplexer with Channel 1R and Channel 
3R

Figure 19 BIST_L Connection Diagram with M8020A JBERT with Channel 1 and Channel 3
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SAS Test Application Overview 3

Figure 20 BIST_L Connection Diagram with M8020A JBERT with Channel 2 and Channel 4

Figure 21 BIST_L Connection Diagram with M8020A JBERT with Channel 1R and Channel 3R
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Figure 22 BIST_L Connection Diagram with M8040A JBERT with Channel 1 and Channel 3

Figure 23 BIST_L Connection Diagram with M8040A JBERT with Channel 1 and Channel 3 for OOB Tests
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SAS Test Application Overview 3

Figure 24 BIST_L Connection Diagram with M8040A JBERT with Channel 2 and Channel 4

Figure 25 BIST_L Connection Diagram with M8040A JBERT with Channel 2 and Channel 4 for OOB Tests
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Figure 26 BIST_L Connection Diagram with M8040A JBERT with Channel 1R and Channel 3R

Figure 27 BIST_L Connection Diagram with M8040A JBERT with Channel 1R and Channel 3R for OOB Tests
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SAS Test Application Overview 3

SavedWFM

When you select SavedWFM, the SAS test application analyzes the loaded waveform. There is no 
specific requirement for connection. You may leave the current connection as it is. The application 
runs on the previously saved WFM file only and does not require a live signal. 

NOTE If Tx Waveform Distortion Penalty (WDP) test is selected, ensure that: 

- A licensed version of MATLAB is installed (MATLAB 2016b and above). 

- SASWDP.m matlab script is available at the following directory C:\ProgramData\Infiniium\
Compliance-Defined Functions 2016B.
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SAS Test Application Test Groups

The test groups in the SAS-4 Compliance Test Application are categorized as:

• TX SAS-SAS Down Spreading Spread Spectrum Clocking Requirements

• TX SAS-SAS Center Spreading Spread Spectrum Clocking Requirements

• TX SAS-SATA Down Spreading Spread Spectrum Clocking Requirements

• TX NRZ Data Signaling Requirements

• TX Coefficient Requests and Circuit Response Requirements

• TX Device End-to-End Simulation Characteristics Requirements

• TX OOB Signaling

Out of these, only the following test groups are available for the 22.5 Gbps bit rate:

• TX SAS-SAS Down Spreading Spread Spectrum Clocking Requirements

• TX SAS-SAS Center Spreading Spread Spectrum Clocking Requirements

• TX NRZ Data Signaling Requirements

• TX Coefficient Requests and Circuit Response Requirements

• TX OOB Signaling
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SAS Test Application Overview 3

Test Availability in the SAS-4 Compliance Test Application

The SAS-4 Compliance Test Application consists of some options in the Set Up tab that determine the 
availability of certain tests. For such tests, if one of the options is disabled, the test is unavailable. 
The options in the Set Up tab, as shown in Figure 28, which primarily affect the availability of tests are:

1 Bit Rate (Gbps)

2 SSC Modulation Type

3 Hide Informative Tests

Figure 28 SAS-4 Configuration Options in the Set Up tab

Bit Rate (Gbps)

The available bit rates are 1.5 Gbps, 3.0 Gbps, 6.0 Gbps, 12.0 Gbps, and 22.5 Gbps. The following are 
the implications of selecting the different bit rates:

• The SATA Down Spreading SSC Modulation Type is not available for 12.0 Gbps and 22.5 Gbps bit 
rates. Hence, the TX SAS-SATA Down Spreading Spread Spectrum Clocking Requirements tests 
are not available for these bit rates.

• The following additional settings are available in the Test Method area when 12.0 Gbps bit rate is 
selected:

• Tx Vpp, ET Test Method

• End-to-End Simulation Type
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Hence, the following additional test groups are available under the Select Tests tab for the 12.0 Gbps 
bit rate:

• TX Coefficient Requests and Circuit Response Requirements tests

• TX Device End-to-End Simulation Characteristics Requirements tests

• The following additional setting is available in the Test Method area when 22.5 Gbps bit rate is 
selected:

• Tx Vpp, ET Test Method

Hence, the following additional test group is available under the Select Tests tab for 22.5 Gbps bit 
rate:

• TX Coefficient Requests and Circuit Response Requirements tests

SSC Modulation Type

The selection(s) made in this area determine the availability of the following test groups under the 
Select Tests tab.

Hide Informative Tests

Selecting this check box hides the informative tests from the test groups. Informative Tests provide 
additional test information about the DUT that is not mandatory to be validated for the compliance 
purpose. For example, the TX SSC DFDT tests in the TX SAS-SAS Down Spreading Spread Spectrum 
Clocking Requirements are Informative Tests and are displayed as "TX SSC DFDT (Informative)" 
under the Select Tests tab. However, when you select the Hide Informative Tests check box under the 
Set Up tab, these tests are hidden from the test group under the Select Tests tab.

To check for the configuration options that impact the availability of each of the tests described in 
this document, refer to the Test Availability section for each test, wherever present.

SSC Modulation Type Serial Attached SCSI (SAS) Tests

SAS Down Spreading TX SAS-SAS Down Spreading Spread Spectrum Clocking Requirements

SAS Center Spreading TX SAS-SAS Center Spreading Spread Spectrum Clocking Requirements

SATA Down Spreading TX SAS-SATA Down Spreading Spread Spectrum Clocking Requirements

NOTE The SATA Down Spreading type is not available for the 12.0 Gbps and 22.5 Gbps bit rates. 
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This section provides the Methods of Implementation (MOIs) for the SAS-SAS Down Spreading 
Spread Spectrum Clocking Requirements tests using a Keysight Infiniium oscilloscope and the SAS-4 
Compliance Test Application.
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Connection for SAS-SAS Down Spreading Spread Spectrum Clocking Requirements Tests

When performing the SAS-SAS Down Spreading Spread Spectrum Clocking tests, the SAS-4 
Compliance Test Application will prompt you to make the proper connections. The connections for 
these tests depend on the Bit Rate and the Test Pattern Source selected under the Set Up tab. Refer to 
the Connect tab in the SAS-4 Compliance Test Application for the exact connections. Additionally, 
refer to “Making Hardware Connections for SAS-4 Compliance Testing" on page 27.

You can configure other settings used in these tests in the Configure tab of the SAS-4 Compliance 
Test Application. 

Test Procedure

1 Start the automated test application as described in “Starting the SAS-4 Compliance Test 
Application" on page 21.

2 In the SAS-4 Compliance Test Application, click the Set Up tab.

3 Select the Bit Rate as 22.5 and in the Device Under Test (DUT) section.

4 Select SAS Down Spreading as the SSC Modulation Type.

5 Click the Select Tests tab and check the tests you want to run. Check the parent node or group to 
check all the available tests within the group.

Figure 29 Selecting SAS Down Spreading Spread Spectrum Tests

6 Follow the SAS-4 Compliance Test Application’s task flow to set up the configuration options, run 
the tests, and view the tests results.
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SAS-SAS Down Spreading Spread Spectrum Clocking Requirements Tests 4

TX SSC Modulation Frequency

Test Overview

The purpose of this test is to verify that the SSC modulation frequency of the signal transmitted by 
the DUT is within the conformance limits. 

For conformance, the TX SSC Modulation Frequency should be greater than or equal to 30.00 kHz 
and less than or equal to 33.00 kHz.

Test Availability

Table 1 shows the configuration options on the SAS-4 Compliance Test Application that affect the 
availability of the TX SSC Modulation Frequency test.

Table 1 Configuration Options for TX SSC Modulation Frequency Test

References

See Section 5.8.6.1 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture a minimum of 2 million samples at a minimum 
sampling rate of 80GSa/s.

3 Configure the DUT to transmit the 1010 pattern at the required bit rate with down spreading SSC 
modulation enabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s differential transmitted data signal.

6 Using post-processing techniques and 4th order Butterworth filter, calculate the 200kHz-filtered 
SSC profile.

7 Measure the frequency of the SSC profile over a minimum of 10 periods to produce the SSC 
modulation frequency.

Expected/Observable Results

The measured value of the SSC modulation frequency of the signal transmitted by DUT must be 
within the conformance limit.

Test Name Test ID SSC Modulation Type

SAS Down 
Spreading

SAS Center 
Spreading

SATA 
Down 

Spreading

TX SSC Modulation Frequency 10121  -
Not 

Applicable
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TX SSC Modulation Deviation

Test Overview

The purpose of this test sub-group is to verify that the maximum and minimum SSC modulation 
deviations of the signal transmitted by the DUT are within the conformance limits.

For conformance, the maximum TX SSC Modulation Deviation should be less than or equal to 100 
ppm and the minimum TX SSC Modulation Deviation should be greater than or equal to -600 ppm.

Test Availability

Table 2 shows the configuration options on the SAS-4 Compliance Test Application that affect the 
availability of the TX SSC Modulation Deviation test.

Table 2 Configuration Options for TX SSC Modulation Deviation Test

References

See Section 5.8.6.1, Table 86 of Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture a minimum of 2 million samples at a minimum 
sampling rate of 80GSa/s.

3 Configure the DUT to transmit the 1010 pattern at the required bit rate with down spreading SSC 
modulation enabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s differential transmitted data signal.

6 Using post-processing techniques and 2nd order Butterworth filter, calculate the 
3.7+/-0.2MHz-filtered SSC profile.

7 Record the maximum and minimum profile peak values of SSC profile over a minimum of 10 
periods.

8 Calculate the SSC modulation deviation using following equation:
SSC Modulation Deviation (Max) = (Bit Rate Max – Bit Rate Nominal)/ (Bit Rate Nominal) * 1E6
SSC Modulation Deviation (Min) = (Bit Rate Min – Bit Rate Nominal)/ (Bit Rate Nominal) * 1E6

Test Name Test ID SSC Modulation Type

SAS Down 
Spreading

SAS Center 
Spreading

SATA 
Down 

Spreading

TX SSC Modulation Deviation 
(Max)

10221  -
Not 

Applicable

TX SSC Modulation Deviation 
(Min)

10222  -
Not 

Applicable

NOTE It is not mandatory that all the recorded values should be acquired from a single, contiguous block 
of SSC cycles. You may record measurements across multiple waveform acquisitions, to gather as 
many data cycles, as might be required.
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SAS-SAS Down Spreading Spread Spectrum Clocking Requirements Tests 4

Expected/Observable Results

The measured value of the minimum and maximum SSC modulation deviations of the signal 
transmitted by the DUT must be within the conformance limits.
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TX SSC DFDT (Informative)

Test Overview

The purpose of this test sub-group is to verify that the maximum and minimum short term rates of 
change (slope) of the SSC modulation profile (dF/dt) are within the conformance limits.

For conformance, the maximum TX SSC DFDT should be less than or equal to 850 ppm/us and the 
minimum TX SSC DFDT should be greater than or equal to -850 ppm/us.

Test Availability

Table 3 shows the configuration options on the SAS-4 Compliance Test Application that affect the 
availability of the TX SSC DFDT test.

Table 3 Configuration Options for TX SSC DFDT Test

References

See Section 5.8.6.1 of Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture a minimum of 2 million samples at a minimum 
sampling rate of 80GSa/s.

3 Configure the DUT to transmit the 1010 pattern at the required bit rate with down spreading SSC 
modulation enabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s differential transmitted data signal.

6 Using post-processing techniques and 2nd order Butterworth filter, calculate the 
3.7+/-0.2MHz-filtered SSC profile.

7 Post-process the profile data to create the DFDT profile using the following differential equation.
DFDT = (f(t) – f(t-0.27µs))/0.27µs
where f(t) is the SSC frequency deviation expressed in ppm

8 Measure and record the maximum and minimum of DFDT values.

Expected/Observable Results

The measured value of the minimum and maximum short term rates of change (slope) of the SSC 
modulation profile (dF/dt) must be within the conformance limits.

Test Name Test ID SSC Modulation Type Hide Informative Tests

SAS Down 
Spreading

SAS Center 
Spreading

SATA 
Down 

Spreading
Enabled Disabled

TX SSC DFDT (Informative) 
(Max)

10621  -
Not 

Applicable
× 

TX SSC DFDT (Informative) 
(Min)

10622  -
Not 

Applicable
× 
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This section provides the Methods of Implementation (MOIs) for the SAS-SAS Center Spreading 
Spread Spectrum Clocking Requirements tests using a Keysight Infiniium oscilloscope and the SAS-4 
Compliance Test Application.
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Connection for SAS-SAS Center Spreading Spread Spectrum Clocking Requirements Tests

When performing the SAS-SAS Center Spreading Spread Spectrum Clocking Requirements tests, 
the SAS-4 Compliance Test Application will prompt you to make the proper connections. The 
connections for these tests depend on the Bit Rate and the Test Pattern Source selected under the Set 
Up tab. Refer to the Connect tab in the SAS-4 Compliance Test Application for the exact connections. 
Additionally, refer to “Making Hardware Connections for SAS-4 Compliance Testing" on page 27.

You can configure other settings used in these tests in the Configure tab of the SAS-4 Compliance 
Test Application. 

Test Procedure

1 Start the automated test application as described in “Starting the SAS-4 Compliance Test 
Application" on page 21.

2 In the SAS-4 Compliance Test Application, click the Set Up tab.

3 Select the Bit Rate as 22.5 and in the Device Under Test (DUT) section.

4 Select SAS Center Spreading as the SSC Modulation Type.

5 Click the Select Tests tab and check the tests you want to run. Check the parent node or group to 
check all the available tests within the group.

Figure 30 Selecting SAS Center Spreading Spread Spectrum Tests

6 Follow the SAS-4 Compliance Test Application’s task flow to set up the configuration options, run 
the tests, and view the tests results.
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SAS-SAS Center Spreading Spread Spectrum Clocking Requirements Tests 5

TX SSC Modulation Frequency

Test Overview

The purpose of this test is to verify that the SSC modulation frequency of the signal transmitted by 
the DUT is within the conformance limits.

For conformance, the TX SSC Modulation Frequency should be greater than or equal to 30.00 kHz 
and less than or equal to 33.00 kHz.

Test Availability

Table 4 shows the configuration options on the SAS-4 Compliance Test Application that affect the 
availability of the TX SSC Modulation Frequency test.

Table 4 Configuration Options for TX SSC Modulation Frequency Test

References

See Section 5.8.6.1 of Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture a minimum of 2 million samples at a minimum 
sampling rate of 80GSa/s.

3 Configure the DUT to transmit the 1010 pattern at the required bit rate with center spreading 
SSC modulation enabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s differential transmitted data signal.

6 Using post-processing techniques and 4th order Butterworth filter, calculate the 200kHz-filtered 
SSC profile.

7 Measure the frequency of the SSC profile over a minimum of 10 periods to produce the SSC 
modulation frequency.

Expected/Observable Results

The measured value of the SSC modulation frequency of the signal transmitted by the DUT must be 
within the conformance limit.

Test Name Test ID SSC Modulation Type

SAS Down 
Spreading

SAS Center 
Spreading

SATA Down 
Spreading

TX SSC Modulation Frequency 10122 - 
Not 

Applicable
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TX SSC Modulation Deviation

Test Overview

The purpose of this test sub-group is to verify that the maximum and minimum SSC modulation 
deviations of the signal transmitted by DUT are within the conformance limits. Further, the TX SSC 
Modulation Deviation Asymmetry test within this test subgroup verifies that the SSC modulation 
deviation asymmetry of the signal transmitted by the DUT is within the conformance limit.

For conformance, the following are the pass limits:

TX SSC Modulation Deviation (Max) <= 600 ppm

TX SSC Modulation Deviation (Min) >= -600 ppm

TX SSC Modulation Deviation Asymmetry <= 288 ppm

Test Availability

Table 5 shows the configuration options on the SAS-4 Compliance Test Application that affect the 
availability of the TX SSC Modulation Deviation test.

Table 5 Configuration Options for TX SSC Modulation Deviation Test

References

See Section 5.8.6.1, Table 86 of Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture a minimum of 2 million samples at a minimum 
sampling rate of 80GSa/s.

3 Configure the DUT to transmit the 1010 pattern at the required bit rate with center spreading 
SSC modulation enabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s differential transmitted data signal.

6 Using post-processing techniques and 2nd order Butterworth filter, calculate the 
3.7+/-0.2MHz-filtered SSC profile.

7 Record the maximum and minimum profile peak values of SSC profile over a minimum of 10 
periods.

Test Name Test ID SSC Modulation Type

SAS Down 
Spreading

SAS Center 
Spreading

SATA Down 
Spreading

TX SSC Modulation Deviation 
(Max)

10321 - 
Not 

applicable

TX SSC Modulation Deviation 
(Min)

10322 - 
Not 

applicable

TX SSC Modulation Asymmetry 10421 - 
Not 

applicable
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SAS-SAS Center Spreading Spread Spectrum Clocking Requirements Tests 5

8 Calculate the SSC modulation deviation using following equation:
SSC Modulation Deviation (Max) = (Bit Rate Max – Bit Rate Nominal)/ (Bit Rate Nominal) * 1E6
SSC Modulation Deviation (Min) = (Bit Rate Min – Bit Rate Nominal)/ (Bit Rate Nominal) * 1E6

9 Calculate the Deviation Asymmetry using the following equation:
Deviation Asymmetry = abs (SSC Modulation Deviation (Max)+ SSC Modulation Deviation (Min))

Expected/Observable Results

The measured value of the minimum and maximum SSC modulation deviations of the signal 
transmitted by the DUT must be within the conformance limits. Further, the SSC modulation 
deviation asymmetry of the signal transmitted by the DUT must be within the conformance limit.

NOTE It is not mandatory that all the recorded values should be acquired from a single, contiguous block 
of SSC cycles. You may record measurements across multiple waveform acquisitions, to gather as 
many data cycles, as might be required.
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TX SSC DFDT (Informative)

Test Overview

The purpose of this test sub-group is to verify that the maximum and minimum short term rates of 
change (slope) of the SSC modulation profile (dF/dt) are within the conformance limits.

For conformance, the maximum TX SSC DFDT should be less than or equal to 850 ppm/us while the 
minimum TX SSC DFDT should be greater than or equal to -850 ppm/us.

Test Availability

Table 6 shows the configuration options on the SAS-4 Compliance Test Application that affect the 
availability of the TX SSC DFDT test.

Table 6 Configuration Options for TX SSC DFDT Test

References

See Section 5.8.6.1 of Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture a minimum of 2 million samples at a minimum 
sampling rate of 80GSa/s.

3 Configure the DUT to transmit the 1010 pattern at the required bit rate with down spreading SSC 
modulation enabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s differential transmitted data signal.

6 Using post-processing techniques and 2nd order Butterworth filter, calculate the 
3.7+/-0.2MHz-filtered SSC profile.

7 Post-process the profile data to create the DFDT profile using the following differential equation.
DFDT = (f(t) – f(t-0.27µs))/0.27µs
where f(t) is the SSC frequency deviation expressed in ppm.

8 Measure and record the maximum and minimum of DFDT values.

Expected/Observable Results

The measured value of the minimum and maximum short term rates of change (slope) of the SSC 
modulation profile (dF/dt) must be within the conformance limits.

Test Name Test ID SSC Modulation Type Hide Informative Tests

SAS Down 
Spreading

SAS Center 
Spreading

SATA Down 
Spreading

Enabled Disabled

TX SSC DFDT (Informative) 
(Max)

10721 - 
Not 

Applicable
× 

TX SSC DFDT (Informative) 
(Min)

10722 - 
Not 

Applicable
× 
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This section provides the Methods of Implementation (MOIs) for the NRZ Data Signaling 
Requirements tests using a Keysight Infiniium oscilloscope and the SAS-4 Compliance Test 
Application.
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Connection for NRZ Data Signaling Requirements Tests

When performing the NRZ Data Signaling Requirements tests, the SAS-4 Compliance Test 
Application will prompt you to make the proper connections. The connections for these tests depend 
on the Bit Rate and Test Pattern Source selected under the Set Up tab. Refer to the Connect tab in the 
SAS-4 Compliance Test Application for the exact connections. Additionally, refer to “Making 
Hardware Connections for SAS-4 Compliance Testing" on page 27.

You can configure other settings used in these tests in the Configure tab of the SAS-4 Compliance 
Test Application. 

Test Procedure

1 Start the automated test application as described in “Starting the SAS-4 Compliance Test 
Application" on page 21.

2 In the SAS-4 Compliance Test Application, click the Set Up tab.

3 Select the Bit Rate as 22.5 in the Device Under Test (DUT) section.

4 Click the Select Tests tab and check the tests you want to run. Check the parent node or group to 
check all the available tests within the group.

Figure 31 Selecting NRZ Data Signaling Requirements Tests

5 Follow the SAS-4 Compliance Test Application’s task flow to set up the configuration options, run 
the tests, and view the tests results.
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TX Physical Link Rate Long Term Stability (Mean)

Test Overview

The purpose of this test is to verify that the mean of the long term stability of the DUT transmitter's 
physical link rate is within the conformance limits.

For conformance, TX Physical Link Rate Long Term Stability (Mean) should be greater than or equal 
to -100 ppm and less than or equal to 100 ppm.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab.

References

See Section 5.8.4.3, Table 44 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Id for this test is 20123.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device. 

2 Configure the oscilloscope to capture a minimum of 2 million samples at a minimum sampling 
rate of 80GSa/s.

3 Configure the DUT to transmit the 1010 test pattern at the required bit rate, with SSC modulation 
disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s differential transmitted data signal.

6 Using post-processing technique and 3.7+/-0.2MHz cutoff frequency 1st order Butterworth filter, 
compute the instantaneous physical link rate.

7 Measure and record the average bit rate value (in ppm) for the entire capture.

Expected/Observable Results

The measured value of the mean of the long term stability of the DUT transmitter's physical link rate 
must be within the conformance limits.
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TX Common Mode RMS Voltage

Test Overview

The purpose of the TX Common Mode RMS Voltage Limit test is to verify that the common mode 
RMS voltage of the DUT's transmitter device is less than the maximum allowed value.

For conformance, TX Common Mode RMS Voltage Limit should be less than or equal to 12 mV.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab.
Test Id for this test is 20221.

References

See Section 5.8.4.8.1, Table 61 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device. 

2 Configure the Infiniium oscilloscope to capture at least 100μs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the DUT to transmit the PRBS15 test pattern at the required bit rate, with SSC 
modulation disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s single-ended transmitted data signal.

6 Using post-processing technique, compute the common-mode signal.

7 Measure and record the RMS value of the common-mode signal.

Expected/Observable Results

The measured values of the common mode signal parameters of the DUT's transmitter device must 
be within the conformance limits.
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TX Common Mode Spectrum

Test Overview

The purpose of the TX Common Mode Spectrum test is to verify that the common mode spectral 
characteristics of the DUT's transmitter device are below the maximum allowed limits.

For conformance, TX Common Mode Spectrum Margin (100MHz - 16.875GHz) (22.5GB) should be 
less than or equal to 0.0000 dB.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab.
Test Id for this test is 20321.

References

See Section 5.8.4.8.1, Table 62 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device. 

2 Configure the Infiniium oscilloscope to capture at least 100μs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the DUT to transmit the PRBS15 test pattern at the required bit rate, with SSC 
modulation disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture one acquisition of the DUT’s single-ended transmitted data signal.

6 Using post-processing technique, compute the spectrum of the common mode signal, expressed 
in dBmV, with an effective resolution bandwidth of 1MHz.

7 Measure and record the minimum margin between the common mode spectrum and the limit line 
in dBmV.

Expected/Observable Results

The measured values of the common mode spectral characteristics of the DUT's transmitter device 
must be below the maximum allowed limits.



6 NRZ Data Signaling Requirements Tests

60 SAS-4 Compliance Test Application Methods of Implementation

TX Common Mode Voltage

Test Overview

The purpose of the TX Common Mode Voltage test is to verify that the common mode voltage of the 
DUT's transmitter device is within the conformance limits.

For conformance, TX Common Mode Voltage Limit should be greater than or equal to -100 mV and 
less than or equal to 1.200 V.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab.
Test Id for this test is 21221.

References

See Section 5.8.4.8.1, Table 61 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device. 

2 Configure the Infiniium oscilloscope to capture at least 100μs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the DUT to transmit the PRBS15 test pattern at the required bit rate, with SSC 
modulation disabled.

4 Verify that the DUT is sourcing valid SAS signaling at the expected rate.

5 Capture one acquisition of the DUT’s single-ended transmitted data signal.

6 Using post-processing technique, compute the common-mode signal.

7 Measure and record the average value of the common-mode signal.

Expected/Observable Results

The measured values of the common mode signal parameters of the DUT's transmitter device must 
be within the conformance limits.
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TX Vpp, IT (TX Peak-to-Peak Voltage, IT)

Test Overview

The purpose of this test is to verify that the peak-to-peak output voltage (Vpp) of the DUT's 
transmitter device is less than the maximum allowed value.

For conformance, TX Peak-to-Peak Voltage should be less than or equal to 1.200 V.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab.
Test Id for this test is 20421.

References

See Section 5.8.4.8.1, Table 61 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture at least 100μs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the DUT to transmit the D30.3 test pattern at the required bit rate, with SSC 
modulation disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 If the count for acquisition averaging from the Average Count (TX Vpp, VMA, EQ) configuration 
variable is greater than 1, set up the Pulse Width Trigger for bit rate less than 22.5 Gbps or 
InfiniiScan Trigger for 22.5 Gbps with Acquisition Averaging enabled.

6 Capture one acquisition of the DUT’s differential transmitted data signal.

7 Calculate the absolute max peak to peak value of the differential signal.

Expected/Observable Results

The measured value of the peak-to-peak output voltage (Vpp) of the DUT's transmitter device must 
be less than the maximum allowed value.
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TX Total Jitter

Test Overview

This test verifies that the transmit jitter of the DUT transmitter device is within the conformance 
limits. 
For conformance, TX Total Jitter (TJ) must be greater than or equal to 0.00000 UI and less than or 
equal to 280.00 mUI.

Test Availability

This test sub-group is not dependent on any settings under the Set Up tab. Hence, this test is 
available for all the values under the Set Up tab.
Test Id for the TX Total Jitter (TJ) test is 20821.
Test Id for the TX Total Jitter (TJ) (SAS-SAS Down Spreading) test is 20822.

Test Id for the TX Total Jitter (TJ) (SAS-SAS Center Spreading) test is 20823.

References

See Section 5.8.4.8.1, Table 61 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture at least 250μs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the oscilloscope to use the JTF that meets the requirements.

4 Configure the DUT to transmit the PRBS15 test pattern at the required bit rate, with SSC 
modulation disabled /enabled (depends on test). 

5 Verify that the DUT is sourcing valid SAS signals at the expected rate.

6 Capture one acquisition of the DUT’s differential transmitted data signal.

7 Using Jitter/Noise tool (EZJIT Complete), perform the jitter decomposition on the differential 
signal.

8 Record the Total Jitter (TJ) of the differential signal.

Expected/Observable Results

The measured value of the jitter of the DUT transmitter device must be within the conformance limits.
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TX Uncorrelated Unbounded Gaussian Jitter

Test Overview

TX Uncorrelated Unbounded Gaussian Jitter (T_UUGJ) - This test verifies that the transmit 
uncorrelated unbounded gaussian jitter of the DUT transmitter device is within the conformance 
limits. 
For conformance, TX Uncorrelated Unbounded Gaussian Jitter should be greater than or equal to 
0.00000 UI and less than or equal to 150.00 mUI.

Test Availability

This test sub-group is not dependent on any settings under the Set Up tab. Hence, this test is 
available for all the values under the Set Up tab.
Test Id for this test is 21321.

References

See Section 5.8.4.8.1, Table 61 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture at least 250μs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the oscilloscope to use the JTF that meets the requirements.

4 Configure the DUT to transmit the PRBS15 test pattern at the required bit rate, with SSC 
modulation disabled. 

5 Verify that the DUT is sourcing valid SAS signals at the expected rate.

6 Capture one acquisition of the DUT’s differential transmitted data signal.

7 Using Jitter/Noise tool (EZJIT Complete), perform the jitter decomposition on the differential 
signal.

8 Calculate and record the Uncorrelated Unbounded Gaussian Jitter (UUGJ) of the differential 
signal based on following equation:
UUGJ = 14 * RJ(rms)

Expected/Observable Results

The measured value of the jitter of the DUT transmitter device must be within the conformance limits.
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TX Uncorrelated Bounded High Probability Jitter

Test Overview

TX Uncorrelated Bounded High Probability Jitter (T_UBHPJ) - This test verifies that the transmit 
uncorrelated bounded high probability jitter of the DUT transmitter device is within the conformance 
limits. 
For conformance, TX Uncorrelated Bounded High Probability Jitter (T_UBHPJ) must be greater than 
or equal to 0.00000 UI and less than or equal to 150.00 mUI.

Test Availability

This test sub-group is not dependent on any settings under the Set Up tab. Hence, this test is 
available for all the values under the Set Up tab.
Test Id for this test is 21421.

References

See Section 5.8.4.8.1, Table 61 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture at least 250μs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the oscilloscope to use the JTF that meets the requirements.

4 Configure the DUT to transmit the PRBS9 test pattern at the required bit rate, with SSC 
modulation disabled. 

5 Verify that the DUT is sourcing valid SAS signals at the expected rate.

6 Capture one acquisition of the DUT’s differential transmitted data signal.

7 Using Jitter/Noise tool (EZJIT Complete), perform the jitter decomposition on the differential 
signal.

8 Calculate and record the Uncorrelated Bounded High Probability Jitter (UBHPJ) of the differential 
signal based on following equation:
UBHPJ = 2*√2 * PJrms + DCD

Expected/Observable Results

The measured value of the jitter of the DUT transmitter device must be within the conformance limits.
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TX Duty Cycle Distortion

Test Overview

The purpose of this test sub-group is to verify that the jitter of the DUT transmitter device is less than 
the maximum allowed limit. The following tests are covered in this test sub-group:

• TX Duty Cycle Distortion (T_DCD) (No Equalization) - This test verifies that the transmit duty cycle 
distortion of the DUT transmitter device with no equalization is within the conformance limits.
For conformance, TX Duty Cycle Distortion (T_DCD) (No Equalization) must be greater than or 
equal to 0.00000 UI and less than or equal to 35.00 mUI.

• TX Duty Cycle Distortion (T_DCD) (With Equalization) - This test verifies that the transmit duty 
cycle distortion of the DUT transmitter device with equalization is within the conformance limits.
For conformance, TX Duty Cycle Distortion (T_DCD) (With Equalization) should be greater than or 
equal to 0.00000 UI and less than or equal to 35.00 mUI.

Test Availability

This test sub-group is not dependent on any settings under the Set Up tab. Hence, this test is 
available for all the values under the Set Up tab.

• Test Id for the TX Duty Cycle Distortion (T_DCD) (No Equalization) test is 21521.

• Test Id for the TX Duty Cycle Distortion (T_DCD) (With Equalization) test is 21522.

References

See Section 5.8.4.8.1, Table 61 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture at least 250μs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the oscilloscope to use the JTF that meets the requirements.

4 Configure the DUT to transmit the 1010 pattern at the required bit rate, with no equalization/with 
equalization (depends on test) and SSC modulation disabled. 

5 Verify that the DUT is sourcing valid SAS signals at the expected rate.

6 Capture one acquisition of the DUT’s differential transmitted data signal.

7 Using Jitter/Noise tool (EZJIT Complete), perform the jitter decomposition on the differential 
signal.

8 Record the Duty Cycle Distortion (DCD) of the differential signal.

Expected/Observable Results

The measured value of the jitter of the DUT transmitter device must be within the conformance limits.
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This section provides the Methods of Implementation (MOIs) for the Coefficient Requests and Circuit 
Response Requirements tests using a Keysight Infiniium oscilloscope and the SAS-4 Compliance 
Test Application.
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68 SAS-4 Compliance Test Application Methods of Implementation

Connection for Coefficient Requests and Circuit Response Requirements Tests

When performing the Coefficient Requests and Circuit Response Requirements tests, the SAS-4 
Compliance Test Application will prompt you to make the proper connections. The connections for 
these tests depend on the Bit Rate and Test Pattern Source selected under the Set Up tab. Refer to the 
Connect tab in the SAS-4 Compliance Test Application for the exact connections. Additionally, refer to 
“Making Hardware Connections for SAS-4 Compliance Testing" on page 27.

You can configure other settings used in these tests in the Configure tab of the SAS-4 Compliance 
Test Application. 

Test Procedure

1 Start the automated test application as described in “Starting the SAS-4 Compliance Test 
Application" on page 21.

2 In the SAS-4 Compliance Test Application, click the Set Up tab.

3 Select the Bit Rate as 22.5 and in the Device Under Test (DUT) section.

4 Click the Select Tests tab and check the tests you want to run. Check the parent node or group to 
check all the available tests within the group.

Figure 32 Selecting TX Coefficient Requests and Circuit Response Requirements Tests for Burst Mode

5 Follow the SAS-4 Compliance Test Application’s task flow to set up the configuration options, run 
the tests, and view the tests results.
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Coefficient Requests and Circuit Response Requirements Tests 7

TX Coefficient Requests and Circuit Response

Test Overview

The purpose of this test is to verify that the transmitter circuit response for the corresponding 
coefficient requests is within the conformance limits.

Test Availability

For 22.5 Gbps bit rate, this test is not dependent on any other settings under the Set Up tab. 

References

See Section 5.8.4.7.2, Table 55 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09. 

Test Id for this test is 40111.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 80GSa/s.

3 Configure the DUT to transmit the long random pattern (i.e. IDLE dwords, PRBS15, etc) at the 
required bit rate, with no equalization and SSC modulation disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture and export between 20,000 UI to 40,000 UI of waveform data.

6 Configure the DUT to transmit the long random pattern (i.e., IDLE dwords, PRBS15, etc) at the 
required bit rate, with default equalization (either no equalization, reference 1 equalization or 
reference 2 equalization) and SSC modulation disabled.

7 Verify that the DUT is sourcing valid SAS signals at the expected rate.

8 Capture and export between 20,000 UI to 40,000 UI of waveform data.

9 Prompt user for the Tx coefficient requests to be tested.

a Configure the DUT to transmit the long random pattern (i.e. IDLE dwords, PRBS15, etc) at the 
required bit rate, with selected Tx coefficient request and SSC modulation disabled.

b Verify that the DUT is sourcing valid SAS signals at the expected rate.

c Capture and export between 20,000 UI to 40,000 UI of waveform data.

10 Repeat Step 9 with as many Tx coefficient request as the user wants to be tested.

11 Post-process the waveform data using the SAS3_EYEOPENING MATLAB script.

12 Once the script has finished, record the result from the output of the script.

13 Verify the measured VHL Delta, V1 Delta, V2 Delta and V3 Delta with the corresponding 
transmitter circuit response limit in Table 55 of the SAS-4 specification.

Expected/Observable Results

The measured value of the transmitter circuit response for the corresponding coefficient requests 
must be within the conformance limit.



7 Coefficient Requests and Circuit Response Requirements Tests

70 SAS-4 Compliance Test Application Methods of Implementation

TX Vpp, ET (TX Peak-to-Peak Voltage, ET)

Test Overview

The purpose of this test is to verify that the peak-to-peak output voltage (Vpp) of the DUT's 
transmitter device at test point ET is greater than the minimum allowed value.

For conformance, TX Peak-to-Peak Voltage, ET must be greater than or equal to 850 mV.

Test Availability

For 22.5 Gbps bit rate, this test is not dependent on any other settings under the Set Up tab. 
Test Id for the TX Peak-to-Peak Voltage, ET test is 40421.

Test Id for the TX Peak-to-Peak Voltage, ET (with .tf4 file) test is 40422.

References

See Section 5.8.4.8.1, Table 61 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

If SAS 3 Eye Opening Script is selected for Tx Vpp, ET Test Method

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 80GSa/s.

3 Configure the DUT to transmit the long random pattern (i.e. IDLE dwords, PRBS15, etc) at the 
required bit rate, with no equalization and SSC modulation disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture and export between 20,000 UI to 40,000 UI of waveform data.

6 Post-process the waveform data using the SAS3_EYEOPENING MATLAB script.

7 Once the script has finished, record the result from the output of the script.

If De_embedding File is selected for Tx Vpp, ET Test Method

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture at least 100µs of signals at a minimum sampling 
rate of 80GSa/s.

3 Configure the DUT to transmit the D30.3 test pattern at the required bit rate with SSC modulation 
disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate. 

5 De-embed the transfer file specified by the Tx Transfer File (TX Vpp) configuration variable in the 
Configure tab on the DUT’s differential transmitted data signal.

6 If the count for acquisition averaging from the Average Count (TX Vpp, VMA, EQ) configuration 
variable is greater than 1, set up the Pulse Width Trigger for bit rate less than 22.5 Gbps or 
InfiniiScan Trigger for 22.5 Gbps with Acquisition Averaging enabled.

7 Capture one acquisition of the DUT’s differential transmitted data signal after de-embedding.

8 Calculate the absolute max peak to peak value of the differential signal after de-embedding.

Expected/Observable Results

The measured value of the peak-to-peak output voltage (Vpp) of the DUT's transmitter device at test 
point ET must be greater than the minimum allowed value.
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TX No Equalization Coefficient Preset

Test Overview

The purpose of this test sub-group is to verify that the output voltage parameters of the DUT 
transmitter device with no equalization are within the conformance limits. This test sub-group 
comprises the following tests:

• TX No Equalization Pre-cursor Equalization Ratio (Rpre) - This test verifies that the pre-cursor 
equalization ratio (Rpre) of the DUT's transmitter device with no equalization is within the 
conformance limits. 
For conformance, TX No Equalization Rpre should be greater than or equal to 840 mV/V and less 
than or equal to 1.19 V/V.

• TX No Equalization Post-cursor Equalization Ratio (Rpost) - This test verifies that the post-cursor 
equalization ratio (Rpost) of the DUT's transmitter device with no equalization is within the 
conformance limits. 
For conformance, TX No Equalization Rpost must be greater than or equal to 840 mV/V and less 
than or equal to 1.19 V/V.

Test Availability

For 22.5 Gbps bit rate, this test is not dependent on any other settings under the Set Up tab. 

• Test ID for TX No Equalization Pre-cursor Equalization Ratio (Rpre) test is 40512.

• Test ID for TX No Equalization Post-cursor Equalization Ratio (Rpost) test is 40513.

References

See Section 5.8.4.7.2, Table 56 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 80GSa/s.

3 Configure the DUT to transmit the long random pattern (i.e. IDLE dwords, PRBS15, etc) at the 
required bit rate, with no equalization and SSC modulation disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture and export between 20,000 UI to 40,000 UI of waveform data.

6 Post-process the waveform data using the SAS3_EYEOPENING MATLAB script.

7 Once the script has finished, record the result from the output of the script.

8 Calculate Rpre for no equalization using the following equation:
Rpre (no equalization) = V3 (no equalization)/V2 (no equalization)

9 Calculate Rpost for no equalization using the following equation:
Rpost (no equalization) = V1 (no equalization)/V2 (no equalization)

Expected/Observable Results

The measured values of the output voltage parameters of the DUT transmitter device with no 
equalization must be within the conformance limits.
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TX Reference 1 Coefficient Preset

Test Overview

The purpose of this test sub-group is to verify that the output voltage parameters of the DUT 
transmitter device with Reference 1 coefficient preset are within the conformance limits. This test 
sub-group comprises the following tests:

• TX Reference 1 Pre-cursor Equalization Ratio (Rpre) - This test verifies that the pre-cursor 
equalization ratio (Rpre) of the DUT's transmitter device with coefficient set to Reference 1 is 
within the conformance limits. 
For conformance, TX Reference 1 Rpre must be greater than or equal to 2.10 V/V and less than or 
equal to 2.97 V/V.

• TX Reference 1 Post-cursor Equalization Ratio (Rpost) - This test verifies that the post-cursor 
equalization ratio (Rpost) of the DUT's transmitter device with coefficient set to Reference 1 is 
within the conformance limits. 
For conformance, TX Reference 1 Rpost must be greater than or equal to 2.94 V/V and less than 
or equal to 4.16 V/V.

Test Availability

For 22.5 Gbps bit rate, this test is not dependent on any other settings under the Set Up tab.

• Test ID for TX Reference 1 Pre-cursor Equalization Ratio (Rpre) test is 40612.

• Test ID for TX Reference 1 Post-cursor Equalization Ratio (Rpost) test is 40613.

References

See Section 5.8.4.7.2, Table 56 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 80GSa/s.

3 Configure the DUT to transmit the long random pattern (i.e. IDLE dwords, PRBS15, etc) at the 
required bit rate, with no equalization and SSC modulation disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture and export between 20,000 UI to 40,000 UI of waveform data.

6 Configure the DUT to transmit the long random pattern (i.e. IDLE dwords, PRBS15, etc) at the 
required bit rate, with reference 1 equalization and SSC modulation disabled.

7 Verify that the DUT is sourcing valid SAS signals at the expected rate.

8 Capture and export between 20,000 UI to 40,000 UI of waveform data.

9 Post-process the waveform data using the SAS3_EYEOPENING MATLAB script.

10 Once the script has finished, record the result from the output of the script.

11 Calculate Rpre for reference 1 equalization using the following equation:
Rpre (reference 1) = V3 (reference 1)/V2 (reference 1)

12 Calculate Rpost for no equalization using the following equation:
Rpost (reference 1) = V1 (reference 1)/V2 (reference 1)

Expected/Observable Results

The measured values of the output voltage parameters of the DUT transmitter device with Reference 
1 coefficient preset must be within the conformance limits.
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TX Reference 2 Coefficient Preset

Test Overview

The purpose of this test sub-group is to verify that the output voltage parameters of the DUT 
transmitter device with Reference 2 coefficient preset are within the conformance limits. This test 
sub-group comprises the following tests:

• TX Reference 2 Pre-cursor Equalization Ratio (Rpre) - This test verifies that the pre-cursor 
equalization ratio (Rpre) of the DUT's transmitter device with coefficient set to Reference 2 is 
within the conformance limits. 
For conformance, TX Reference 2 Rpre must be greater than or equal to 1.05 V/V and less than or 
equal to 1.49 V/V.

• TX Reference 2 Post-cursor Equalization Ratio (Rpost) - This test verifies that the post-cursor 
equalization ratio (Rpost) of the DUT's transmitter device with coefficient set to Reference 2 is 
within the conformance limits. 
For conformance, TX Reference 2 Rpost must be greater than or equal to 1.19 V/V and less than 
or equal to 1.68 V/V.

Test Availability

For 22.5 Gbps bit rate, this test is not dependent on any other settings under the Set Up tab. 

• Test ID for TX Reference 2 Pre-cursor Equalization Ratio (Rpre) test is 40712.

• Test ID for TX Reference 2 Post-cursor Equalization Ratio (Rpost) test is 40713.

References

See Section 5.8.4.7.2, Table 56 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 80GSa/s.

3 Configure the DUT to transmit the long random pattern (i.e. IDLE dwords, PRBS15, etc) at the 
required bit rate, with no equalization and SSC modulation disabled.

4 Verify that the DUT is sourcing valid SAS signals at the expected rate.

5 Capture and export between 20,000 UI to 40,000 UI of waveform data.

6 Configure the DUT to transmit the long random pattern (i.e. IDLE dwords, PRBS15, etc) at the 
required bit rate, with reference 2 equalization and SSC modulation disabled.

7 Verify that the DUT is sourcing valid SAS signals at the expected rate.

8 Capture and export between 20,000 UI to 40,000 UI of waveform data.

9 Post-process the waveform data using the SAS3_EYEOPENING MATLAB script.

10 Once the script has finished, record the result from the output of the script.

11 Calculate Rpre for reference 2 equalization using the following equation:
Rpre (reference 2) = V3 (reference 2)/V2 (reference 2)

12 Calculate Rpost for no equalization using the following equation:
Rpost (reference 2) = V1 (reference 2)/V2 (reference 2)

Expected/Observable Results

The measured values of the output voltage parameters of the DUT transmitter device with Reference 
2 coefficient preset must be within the conformance limits.
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This section provides the Methods of Implementation (MOIs) for OOB Signaling tests using Keysight 
Infiniium Oscilloscope and the SAS-4 Compliance Test Application.
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Connection for OOB Signaling Tests

When performing the OOB Signaling tests, the SAS-4 Compliance Test Application will prompt you 
to make the proper connections. The connections for these tests depend on the Bit Rate and Test 
Pattern Source selected under the Set Up tab. Refer to the Connect tab in the SAS-4 Compliance Test 
Application for the exact connections. Additionally, refer to “Making Hardware Connections for 
SAS-4 Compliance Testing" on page 27.

You can configure other settings used in these tests in the Configure tab of the SAS-4 Compliance 
Test Application. 

Test Procedure

1 Start the automated test application as described in “Starting the SAS-4 Compliance Test 
Application" on page 21.

2 In the SAS-4 Compliance Test Application, click the Set Up tab.

3 Select the Bit Rate as 22.5 and in the Device Under Test (DUT) section.

4 Click the Select Tests tab and check the tests you want to run. Check the parent node or group to 
check all the available tests within the group.

Figure 33 Selecting OOB Signaling Tests

5 Follow the SAS-4 Compliance Test Application’s task flow to set up the configuration options, run 
the tests, and view the tests results.
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NOTE When using M8040A as the test pattern source, ensure that the deskew 
value of M8045A between Channel 1 and Channel 2 is measured and set 
using the Deskew Value (ps) (Data Rate 1.5Gbps) configuration variable 
in the Configure tab.
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TX Maximum Noise During OOB Idle

Test Overview

The purpose of this test is to verify that the peak noise during OOB idle of the DUT transmitter is 
within the conformance limit.

For conformance, TX Maximum Noise During OOB Idle should be greater than or equal to 0.000 V 
and less than or equal to120 mV.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab. This test, however, is not available when running Infiniium Offline.

Test id for this test is 30101.

References

See Section 5.8.1, Table 42 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Capture one acquisition of DUT’s COMINIT/COMRESET OOB differential signal.

5 Using post-processing techniques, identify the location of the burst and idle of the OOB 
differential signal.

6 Measure and record the maximum peak-to-peak differential noise level observed during the idle 
time of the OOB differential signal.

Expected/Observable Results

The measured value of the peak noise during OOB idle of the DUT transmitter must be within the 
conformance limit.
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TX OOB Burst Amplitude Vpp

Test Overview

The purpose of this test is to verify that the maximum peak to peak voltage of the DUT transmitter 
OOB bursts is within the conformance limits.

For conformance, TX OOB Burst Amplitude Vpp should be less than or equal to 1.200 V.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab. This test, however, is not available when running Infiniium Offline.

Test id for this test is 30201.

References

See Section 5.8.4.9, Table 66 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Capture one acquisition of DUT’s COMINIT/COMRESET OOB differential signal.

5 Using post-processing techniques, identify the location of the burst and idle of the OOB 
differential signal.

6 Calculate the maximum peak-to-peak differential voltage during the burst time of the OOB 
differential signal.

Expected/Observable Results

The maximum peak to peak voltage of the DUT transmitter OOB bursts must be within the 
conformance limits.
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TX OOB Burst Amplitude Minimum (Zero-Length Test Load)

Test Overview

The purpose of this test is to verify that the minimum amplitude of the DUT transmitter OOB bursts is 
within the conformance limit.

For conformance, TX OOB Burst Amplitude Minimum (Zero-Length Test Load) must be greater than 
or equal to 240 mV.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab. This test, however, is not available when running Infiniium Offline.

Test id for this test is 30202.

References

See Section 5.8.4.9, Table 66 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Capture one acquisition of DUT’s COMINIT/COMRESET OOB differential signal.

5 Using post-processing techniques, identify the location of the burst and idle of the OOB 
differential signal.

6 Calculate the minimum amplitude value during the burst time of the OOB differential signal.

Expected/Observable Results

The measured value of the minimum amplitude of the DUT transmitter OOB bursts must be within 
the conformance limit.
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TX OOB Burst Amplitude Minimum (TCTF Test Load)

Test Overview

The purpose of this test is to verify that the minimum amplitude of the DUT transmitter OOB bursts is 
within the conformance limit.

For conformance, TX OOB Burst Amplitude Minimum (TCTF Test Load) should be greater than or 
equal to 240 mV.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab. This test, however, is not available when running Infiniium Offline.

Test id for this test is 30203.

References

See Section 5.8.4.9, Table 66 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Embed the TCTF test load transfer function to the OOB differential signals.

5 Capture one acquisition of DUT’s COMINIT/COMRESET OOB differential signal after embedding 
TCTF test load.

6 Using post-processing techniques, identify the location of the burst and idle of the OOB 
differential signal after embedding TCTF test load.

7 Calculate the minimum amplitude value during the burst time of the OOB differential signal after 
embedding TCTF test load.

Expected/Observable Results

The measured value of the minimum amplitude of the DUT transmitter OOB bursts must be within 
the conformance limit.



8 OOB Signaling Tests

82 SAS-4 Compliance Test Application Methods of Implementation

TX OOB Offset Delta

Test Overview

The purpose of this test is to verify that the OOB offset delta of the DUT transmitter device is within 
the conformance limit.

For conformance, TX OOB Offset Delta must be greater than or equal to -25 mV and less than or 
equal to 25 mV.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab. This test, however, is not available when running Infiniium Offline.

Test id for this test is 30301.

References

See Section 5.8.4.9, Table 66 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Capture one acquisition of DUT’s COMINIT/COMRESET OOB differential signal.

5 Using post-processing techniques, identify the location of the burst and idle of the OOB 
differential signal.

6 Calculate the maximum offset delta by measuring the average voltage during the burst time of 
the OOB differential signal.

Expected/Observable Results

The measured value of the OOB offset delta of the DUT transmitter device must be within the 
conformance limit.
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TX OOB Common Mode Delta

Test Overview

The purpose of this test is to verify that the OOB common mode delta of the DUT transmitter device 
is within the conformance limit.

For conformance, TX OOB Common Mode Delta must be greater than or equal to -50 mV and less 
than or equal to 50 mV.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab. This test, however, is not available when running Infiniium Offline.

Test id for this test is 30401.

References

See Section 5.8.4.9, Table 66 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Capture one acquisition of DUT’s COMINIT/COMRESET OOB single-ended signal.

5 Using post-processing techniques, identify the location of the burst and idle of the OOB 
single-ended signal.

6 Compute the common-mode signal.

7 Calculate the maximum common mode delta by measuring the average voltage of the 
common-mode signal during the burst time of the OOB single-ended signal.

Expected/Observable Results

The measured value of the OOB common mode delta of the DUT transmitter device must be within 
the conformance limit.
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RECEIVE COMINIT Idle Time

Test Overview

The purpose of this test is to verify that the DUT transmits the OOB signal COMINIT idle time within 
conformance limits.

For conformance, RECEIVE COMINIT Idle Time should be greater than or equal to 304.00 ns and less 
than or equal to 336.00 ns.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab. This test, however, is not available when running Infiniium Offline.

Test id for this test is 31101.

References

See Section 5.11.3, Table 93 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Capture one acquisition of DUT’s COMINIT/COMRESET OOB differential signal.

5 Using post-processing techniques, identify the location of the burst and idle of the OOB 
differential signal.

6 Compute and record the idle time between the burst of COMINIT/COMRESET OOB differential 
signal.

Expected/Observable Results

The DUT must transmit the OOB signal COMINIT idle time within the conformance limits.
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RECEIVE COMSAS Idle Time

Test Overview

The purpose of this test is to verify that the DUT transmits the OOB signal COMSAS idle time within 
conformance limits.

For conformance, RECEIVE COMINIT Idle Time should be greater than or equal to 911.70 ns and less 
than or equal to 1008.00 ns.

Test Availability

This test is not dependent on any settings under the Set Up tab. Hence, this test is available for all 
the values under the Set Up tab. This test, however, is not available when running Infiniium Offline.

Test id for this test is 31201.

References

See Section 5.11.3, Table 93 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Capture one acquisition of DUT’s COMSAS OOB differential signal.

5 Using post-processing techniques, identify the location of the burst and idle of the OOB 
differential signal.

6 Compute and record the idle time between the burst of COMSAS OOB differential signal.

Expected/Observable Results

The DUT must transmit the OOB signal COMSAS idle time within the conformance limits.
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RECEIVE COMWAKE Idle Time

Test Overview

The purpose of this test is to verify that the DUT transmits the OOB signal COMIWAKE idle time 
within conformance limits.

For conformance, RECEIVE COMWAKE Idle Time should be greater than or equal to 101.30 ns and 
less than or equal to 112.00 ns.

Test Availability

This test is only available for Host. This test, however, is not available when running Infiniium Offline.

Test id for this test is 31301.

References

See Section 5.11.3, Table 93 of the Serial Attached SCSI-4 (SAS-4) Specification Revision 09.

Test Procedure

1 Connect the Zero-Length test load to the DUT transmitter device.

2 Configure the Infiniium oscilloscope to capture samples of a minimum sampling rate of 40GSa/s.

3 Configure the DUT to source valid OOB signals.

4 Capture one acquisition of DUT’s COMWAKE OOB differential signal.

5 Using post-processing techniques, identify the location of the burst and idle of the OOB 
differential signal.

6 Compute and record the idle time between the burst of COMWAKE OOB differential signal.

Expected/Observable Results

The DUT must transmit the OOB signal COMWAKE idle time within the conformance limits.



Keysight D9040SASC SAS-4 Compliance Test Application
Methods of Implementation

9 Calibrating the Infiniium 
Oscilloscope

Required Equipment for Oscilloscope Calibration  /  88
To Run the Self Calibration  /  89
Channel-to-Channel De-skew  /  94

This section describes the calibration procedures for Keysight Infiniium Oscilloscopes other than the 
UXR-series oscilloscopes. For the calibration information related to the UXR-series oscilloscopes, 
refer to Keysight Infiniium UXR Real-Time Oscilloscopes User’s Guide.

Additionally, probe calibration and de-skew steps have been described in this section. To get more 
information, you can refer to the respective probes documentation.
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Required Equipment for Oscilloscope Calibration

To calibrate the Infiniium oscilloscope in preparation for running the SAS-4 automated tests, you 
need the following equipment:

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• 9000, S-Series and 90000A series oscilloscope: Precision 3.5 mm BNC to SMA male adapter, 
Keysight p/n 54855-67604, qty = 2 (provided with the Keysight Infiniium oscilloscope).

• V, X and Z series oscilloscope: 3.5mm Female to Female adapter, Keysight p/n 5061-5311, qty = 2 
(provided with Keysight Infiniium oscilloscope).

• Calibration cable (provided with the Keysight Infiniium oscilloscopes). Use a good quality 50 Ω 
BNC cable.
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To Run the Self Calibration

The self calibration uses signals generated in the Oscilloscope to calibrate Channel sensitivity, 
offsets, and trigger parameters. You should run the self calibration

• yearly or according to your periodic needs,

• when you replace the acquisition assembly or acquisition hybrids,

• when you replace the hard drive or any other assembly,

• when the oscilloscope’s operating temperature (after the 30 minute warm-up period) is more than 
±5 °C different from that of the last calibration.

Internal or Self Calibration

This will perform an internal diagnostic and calibration cycle for the oscilloscope. For the Keysight 
oscilloscope, this is referred to as Calibration. This Calibration will take about 20 minutes. Perform 
the following steps:

1 Set up the oscilloscope with the following steps:

a Connect the keyboard, mouse, and power cord to the rear of the oscilloscope.

b Plug in the power cord.

c Turn on the oscilloscope by pressing the power button located on the lower left of the front 
panel.

d Allow the oscilloscope to warm up at least 30 minutes prior to starting the calibration 
procedure in step 3 below.

2 Locate and prepare the accessories that will be required for the internal calibration:

a Locate the BNC shorting cap.

b Locate the calibration cable.

c Locate the two Keysight precision SMA/BNC or SMA female to female connector adapters.

d Attach one SMA adapter to the other end of the calibration cable — hand tighten snugly.

e Attach another SMA adapter to the other end of the calibration cable — hand tighten snugly.

NOTE
Let the Oscilloscope warm up before adjusting. Warm up the Oscilloscope for 30 minutes before 
starting calibration procedure. Failure to allow warm up may result in inaccurate calibration.

NOTE
Calibration time: It takes approximately 1 hour to run the self calibration on the Oscilloscope, 
including the time required to change cables from Channel to Channel.
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3 From the Infiniium Oscilloscope’s main menu, click Utilities>Calibration....

Figure 34 Accessing Calibration dialog on the Oscilloscope

The Calibration dialog appears.
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4 To start the calibration process:

a Clear the Cal Memory Protect checkbox.

You cannot run self calibration if this box is checked. See Figure 35.

Figure 35 Clearing Cal Memory Protect and Starting Calibration

b Click Start to begin calibration.

c Follow the on-screen instructions.
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d During the calibration of any Oscilloscope Channel, if the oscilloscope prompts you to perform 
a Time Scale Calibration, select Standard Cal and Default Time Scale in the Calibration Options 
dialog.

Figure 36 Selecting options from the Calibration Options dialog

The options under the Calibration Options dialog are:

• Standard Calibration—Oscilloscope does not perform time scale calibration and uses calibration 
factors from the previous time scale calibration and the reference signal is not required. The 
rest of the calibration procedure continues.

• Standard and Time Scale Cal—Oscilloscope performs time scale calibration. You must connect a 
reference signal to the Oscilloscope Channel, after ensuring that the reference signal meets 
the following specifications. Failure to meet these specifications result in an inaccurate 
calibration.

• Standard Cal and Default Time Scale—Oscilloscope uses the default time scale calibration factors 
and does not require the 10 MHz reference signal. The rest of the calibration procedure 
continues.

e Disconnect everything from all inputs and Aux Out.

f Connect the calibration cable from Aux Out to a specific Channel.

g Connect the calibration cable from Aux Out to each of the Channel inputs as requested.

h Connect the 50 Ω BNC or SMA cable from the Aux Out to the Aux Trig on the front panel of the 
Oscilloscope.

i A Passed/Failed indication is displayed for each calibration section. If any section fails, check 
the calibration cables and run the Oscilloscope Self Test... in the Utilities... menu. 

j After the calibration procedure is completed, click Close.
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NOTE
These steps do not need to be performed every time a test is run. However, if 
the ambient temperature changes more than 5 degrees Celsius from the 
calibration temperature, this calibration should be performed again. The delta 
between the calibration temperature and the present operating temperature is 
shown in the Utilities>Calibration menu.
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Channel-to-Channel De-skew

This procedure ensures that the timing skew errors between Channel 1 and Channel 3 are minimized. 
In addition to the required equipment, you need:

• SMA T-adapter

• Additional BNC to SMA male adapter (two precision 3.5 mm BNC to SMA male adapters are 
provided with the oscilloscope)

To perform the Channel-to-Channel de-skew:

1 Connect the Channel 1 and Channel 3 SMA cables to the oscilloscope's Aux Out:

a Leave the RG-316 cables and SMA adapters on Channel 1 and Channel 3.

b Install a BNC to SMA male adapter on the oscilloscope Aux Out.

c Connect the middle branch of the SMA T-adapter to the SMA adapter on the Aux Out BNC.

d Connect the far end of the cable from the Channel 1 SMA adapter, to one branch of the SMA 
T-adapter on the Aux Out.

e Connect the far end of the cable from the Channel 3 SMA adapter, to the other branch of the 
SMA T-adapter on the Aux Out.

Figure 37 Oscilloscope connections

2 Set up the oscilloscope:

a From the oscilloscope's main menu, choose File>Open>Setup...

b In the Open Setup File dialog, select the "INF_SMA_Deskew.set" setup file, and click Open.

NOTE
For Infiniium 90000 X-Series, S-Series, V-Series and Z-Series oscilloscopes, you must manually 
enable the Aux Output:

1. From the oscilloscope's main menu, choose Utilities>Calibration Output....
2. In the Calibration Output dialog, select the Aux Out Enable check box.
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Figure 38 Open Setup File dialog

If the setup file is not available, it can be created by following the instructions in “INF_SMA_Deskew.set Setup File 
Details”.

3 Observe the Channel-to-Channel skew.
The oscilloscope display should look similar to the picture below. A falling edge of the square 
wave is shown in a 200 ps/div horizontal scale. The upper portion of the screen shows Channel 1 
(yellow trace) and Channel 3 (purple trace) superimposed on one another. The lower portion of 
the screen is the differential signal (green trace) of Channel 1 minus Channel 3. The top two 
traces provide for visual inspection of relative time skew between the two Channels. The bottom 
trace provides for visual presentation of unwanted differential mode signal resulting from relative 
Channel skew (and to a much lesser extent from other inevitable Channel mismatch parameters 
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like gain and non-linearity). The picture below is an example of exaggerated skew between 
Channel 1 and Channel 3, measured to be about 50 ps with the cursor.

Figure 39 Channel-to-Channel Deskew
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The following picture shows the desired effect of no skew between the cables. Note that the Channel 
1 (yellow trace), Channel 3 (purple trace) traces overlap, and the differential signal (green trace) is 
flat. If this is not the case, then perform the following steps to reduce the skew between Channels 1 
and 3.

Figure 40 No Channel-to-Channel Deskew
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4 De-skew the Channels:

a Choose Setup>Channel 3....

b Move the Channel Setup dialog to the left so you can see the traces.

c Adjust the Skew (by clicking on the < or > arrows) to achieve the flattest response on the 
differential signal (blue trace).

Figure 41 Skew adjustment

d Click Close to close the Channel Setup dialog.

5 Disconnect the cables from the T-adapter on the Aux Out BNC. Leave the cables connected to 
the Channel 1 and Channel 3 inputs.

INF_SMA_Deskew.set Setup File Details

NOTE
Each cable is now calibrated for the oscilloscope Channel it is connected to. Do not switch cables 
between Channels or other oscilloscopes, or it will be necessary to calibrate them again. It is 
recommended that the cables be labeled with the Channel they were calibrated for.

NOTE
For Infiniium 90000 X-Series, S-Series, V-Series and Z-Series oscilloscopes, you must manually 
enable the Aux Output:

1. From the oscilloscope's main menu, choose Utilities>Calibration Output....
2. In the Calibration Output dialog, select the Aux Out Enable check box.



SAS-4 Compliance Test Application Methods of Implementation 99

Calibrating the Infiniium Oscilloscope 9

If the INF_SMA_Deskew.set file is not available, you can create it by following these instructions.:

1 Start from a default setup by pressing the Default Setup key on the front panel. Then, configure 
the following settings:

2 From the oscilloscope's main menu, choose File>Save>Setup..., enter the file name 
"INF_SMA_Deskew.set", and click Save.

Oscilloscope Features Configuration values

Acquisition Averaging on, number of averages 16, Interpolation on

Channel 1 Scale 100.0 mV/, Offset −350 mV, Coupling DC, Impedance 50 Ohms

Channel 3 Turn Channel On; Scale 100.0 mV/, Offset −350 mV, Coupling DC, Impedance 50 
Ohms

Time base Scale 200 ps/div

Trigger Trigger level −173 mV, Slope falling

Function 2 Turn on and configure for channel 1 subtract channel 3, Vertical scale 50 mV/, 
Offset 100.000 mV
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